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Defining Business Integration
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Integration

The efficient and flexible combination of resources
to optimize operations across and beyond the enterprise
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People Processes Information
» Portal — personalized information » Workflow management » Federation & data placement (replication,
> Collaboration technology > B2B connectivity ETL, caching)
» Adaptable workplace » Messaging infrastructure (EAI) » XML (store, query, webservices)
» Consistent rule-based experience across . o Bysiness transactions ~ Meta-data management
devices > Service-oriented architecture » Text Search and analytics

40% of people’s time is 40% of IT budgets may | 30-50% of design time is | 85% of information is
spent searching for be spent on integration copy management unstructured
relevant information

® for each $1 spent for a packaged application, customers spend $5 to $9 on the labor for integration !
(IBM Customer Surveys, 2001, 2002)

Can | create business value from my existing IT systems? } People, Process, Information
Can users react in real-time to the most recent information? } People, Information

Are business operations fully integrated for optimal efficiency? > Process, Information
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IBM Information Integration Vision

Any Data
» Multiple access paradigms

» Multiple integration disciplines

XQuery Content Search

-— -— [ ] :::- — ~

- ~
Federate £ Transform | Place Publish

N —

Federated Event

zSeries Il Offering : Data Publishing

© IBVIKstirporation 2004




IBM Software Group | WebSphere Information Integration Software

IBM WebSphere Information Integration Software

H a . . . [ | I
Integrating diverse business information Data federatlon.
» Extensible read/write access across

across and beyond the enterprise diverse data and content sources

» Database programming model (SQL)
» Content programming model (OO API)

= Data placement

» Caching and replication over
heterogeneous information

= Data transformation
» SQL, XML, Web services
» Advanced search and mining
» Metadata management

= Part of a complete integration
solution
» XML publishing, consumption, and

Information Integration : interchange

> Data Federation »  WebSphere business integration
. . » Open platform based on industr

» Data Replication Stgndaﬁds y

» Event Publishing
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IBM Strategy: Heterogeneous Information GRIDs

Getting Access to Information regardless of where it resides ...
Grid Computing...The Ultimate Objective

Distributed computing based on
open standards enabling
heterogeneous resources

... leveraging existing Assets of an open on demand Infrastructure
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Using Websphere Information Integrator as GRID Enabler

= Leverage IT Infrastructure

= Accessing Information F ederation
regardless of Database instead of
Management System and i E. V\Centralization
Structure
DB2

WebSphere Information Integrator

Information Virtualization

s s %

File System / Storage Virtualization
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Federated Data Server
» WebSphere Information Integrator Classic Federation — z/OS Platforms
> WebSphere Information Integrator - LUW Platforms
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WebSphere Information Integrator Classic Federation for z/OS

= Typical Large IT Enterprise Environment

» Decades of heterogeneous technology investment :
60% of data resides on mainframe and is growing 20% per year

» Real-time access to mainframe—based data to remain competitive

» High performance and scalability are mandatory

= WebSphere Information Integrator Classic Federation for z/OS

» Read/Write mainframe data sources using SQL through
standard ODBC, JDBC, CLI

» Native database connectors
leverage power of each
database/file accessed

» Metadata-driven means:
* No mainframe programming

N/
required i
- Fast installation, configuration pB2UDB VSAM& IMS  Software AG CA CA
& ease of maintenance forz/0S  sequential Adabas  Datacom IDMS
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WebSphere Information Integratror (Zasscc Federation

AIX, HP-UX, Solaris, JVM 1.2,
Widows NT, 2000, XP,
2/0S, 0S/390

z/0S
0S/390 o —
Metadata
Catalog

Data
Connector

ODBC Client

Data Data Data
Connector Connector Connector

= -~

Data Data
Connector Connector

CA-Datacom
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WebSphere |l Classic Federation: Standard SQL 92 Support
= SELECT/INSERT/UPDATE/DELETE all supported

= Standard SQL error handling
» SQL error and response codes returned as part of result

= Single and two phase commit
» Commit - Rollback - Autocommit supported for all data sources
» Rolling delivery of two phase commit: DB2, IMS and CA-Datacom available now

= Stored Procedure “Call” leverages existing programs
» Reuse mainframe algorithms
» Invoke IMS transactions

= DBCS Support
» Client-based conversion
» IMS, VSAM, DB2, CA-IDMS, sequential in v8.2
- Adabas mixed mode available, full graphic data type support planned
« CA-Datacom planned

© IBMSBrporation 2004 " S .*"' Information Integration - z/OS landscape
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Platform Support

= Operating Systems
» Server:
- z2/0S 1.4

» Clients:
« AIX 5.1.0, HP-UX 11.01, Solaris 2.7
* Windows* (NT, 2000, XP or Server 2003)

= Communications
» TCP/IP or MQ Series v5 or higher

= Databases
» DB2 UDB for z/OS 6.1 or 7.1
» IMS/DB 7.1
» CA-IDMS 13 or 14
» CA-Datacom 10
» Adabas 7.1

A

i

DB2 UDB VSAM & IMS Software AG CA CA
for z/0S sequential Adabas Datacom IDMS

* Data Mapper requires NT, 2000 or XP

: B K 8 . : . e
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WebSphere and Il Classic Federation

___ = Integrate mainframe data directly with
/W cbophiete fepilcalion Ser"eN Web applications, Portals, EAI
platforms

= Supports JDBC 2.1 Core APIs Plus
» Scrollable/Updatable ResultSets

34¢ Fede_ration » Commit — Rollback — AutoCommit - XA
JDBC Client » Stored Procedure to mainframe
programs

» Parameter Markers

» Metadata commands for tables,
columns, keys, procedures, ...

Websphere Information Integrator
(laseic Federation for z/OS

- : » Connection Pooling Support via
~ E Relational Resource Adapter (RRA)
' » SQLBatch Operations
DB2UDB VSAM IMS SAG CA CA » Statement commands e.g. re-execution
for z/0S Adabas Datacom IDMS of prepared statements

© IBMEeBrporation 2004 I* TN £ 1 Information Integration - z/OS landscape
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Integrating Classic Legacy Data with WS 1l Classic Federation

Access various kinds
of legacy data sources

» Native SQL/JDBC
Interface not available

» Programming skills falling
short

» Mapping of non-relational
legacy Data into
relational Format

» Access Legacy Data
through JDBC Interface

» Legacy Sources can be
mapped into WebSphere
Il Nicknames

© IBMSBrporation 2004 "

SQL, SQL/XML
AN D NN

N\~

WebSphere Information-integrator

(lassce Federation for z/0OS
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Integration in Action — European Catalog House

Seamlessly share order processing data and algorithms between:
» Legacy call-center systems
» New e-commerce applications

» No mainframe skills required for e-commerce site development

Call-Center
Rep

,Customer

Order
Plrocessing

Customer

Ship:to
Date Calc

Customer

© IBVIKstirporation 2004

mation Integration - 2/OS landscape




IBM Software Group | WebSphere Information Integration Software

Integration in Action — Recreation Vehicle Manufacturer

Provide accurate inventory and sales data to data warehouse
» Dynamically connect data warehouse tool with mainframe data

» Cut development time in half

> Accelerate product delivery with warehouse “pull” of new shipment data

>
Order [N Credit
Processingity Accurate
r ML“nV:";%rgnt information
- o ] — .

@ Business BN
R Intelligence i
i

|

pa\Varehouse iy

Federation

TCP/IP

bt Builders
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Speeding Portal Development

Business Scenario

Account Status

» Providing Portal Developers with a | .
single Interface for structured and
unstructured Information
SQL
; SQL/XML Docs, EMails
| _ _ XML-UDF's
& Portal <um) El
N Application
Type 4 JDBC Driver

J2EE 1.4 /JDBC 3.0
DB2 .NET Data Provider

.NET UDF/ SP ML Repository

» Simpler to develop
» Easier to maintain

, B ® ok i . ‘ " o
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Extending Data Warehouses with Real-Time Data

Business Scenario

> Access current customer
records from a call centre

» Access current stock levels
from a supply chain data mart

» Basel Il compliance

» Business activity monitoring —
linking events to trends

© IBIKsrporation 2004
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Integrating Enterprise Data

Integrated SQL View

WebSphere
Information Integrator

SQL, SQL/XML
WebSphere |l S
i ' (@lassce Federation RO

Wrappers and functions 1 ‘
SAG - )

.. !!
Adabas ====,
Datacom | New

CA (,
IDMS |

~ _ IBM
Y >/ nd jd “ 7 Extended
Packaged N o BN - ,
4 apps Biological Data ~_F
And Algorithms Text Excel WebSphere

© IBMSBrporation 2004 k" g N ey IBM Information Integration - z/OS landscape
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Access Distributed Heterogeneous Data from CICS Applications

Business Scenario

» Access all kinds of CICS/IMS Applications
WebSphere Il Data Sources on z/0S

from legacy Applications

» Single Site Update, Multi
Site Read

» Distributed UOW with 2PC
support in plan for following
version of WebSphere Il

WebSphere Information Integratot
Database configured as
DB2 z/0OS CDB Location

Distributed Hetero-
geneous Data Sources
are accessed (read/write)
through WebSphere Informa
Integrator Nicknames

=

WebSphere
Information Integrator

3

“HORACLE

net8

: 8 ® ol L ) : v ~e
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Information and Process Integration with WebShpere

Business Scenario

>

© IBVIKstirporation 2004

Enterprise Applications provide
APIls for Business

Object/Component Retrieval SQL, SQL/XML

Enterprise Business
Components can be mapped
into relational Format using
WebSphere components :

v Information Integration

v' Business Adapters

WebSphere

Information: Integrator

WebSphere Wrappers for Integrated
_ _ o Business Integrator Business Objects
Business Objects can be joined
with other relational / non-

relational Information

oK

Enterprise Applications
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Enabling Customer 360° Analysis
CRM Systems offer 3600 Analysis

» Without federated Information, all
Customer Data has to be moved into
the CRM database or accessed via
individual Adapters

Customer Database

Contract Database

o

SQL
SQL/XML
Web Services

CRM
8, M| i -

WebSphere Information
Integrator

3

ORACLE
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Federate or Replicate — That is the Question !!

Data Federation

» SQL Transparency
» Real-Time Access
» Global Optimization
» SQL Pushdown

DB2 Federated DB2 and Non-DB2
Database ‘ Databases

Data Replication

» Data Movement

» Data Transformation
» Autonomy

DB2 Target DB2 and Non-DB2
Database Databases

, B ® ok 1 . ‘ " e
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Replicated Data
» SQL Replication
> Q Replication
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Why Replicate?

= Distribution / Consolidation = Availability
» Move data between central to branches, » Scheduled outage, failover,
branches to central, or both disaster recovery
» Federate or Replicate ? - can use Hardware and/or Software
- where does the application need the data ?  * replication offers lower expense,
- does the data need to be real time ? faster restart, multi-purpose
- what is the change volume ? - Hardware offers simplicity of setup

» Move query or reporting work
= Warehouse / Business Intelligence to a separate system

» Move data to new platform/database, ’ g}ggr rgsestir:)?gs such as flash copy
transform data P

» ETL or Replicate? » Peer to peer - split workload

’ Ia};tency ”e?ds ol - only possible through replication
change volume versus total volume . requires serious planning

- complexity of transformation and/or and consideration

cleansing
- Mobile Workforce \
» Occasionally connected

distribution/consolidation

© IBMEeBrporation 2004, " s A ,*"’ 'IBM Information Integration - z/OS landscape
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SQL Replication Architecture

\ Staging tables
|

Log based

Trigger based

= Actual Implementation
» DB2 Data Propagator
» WebSphere Il Replication Edition
» IMS Data Propagator

Nicknames

External application

= Actual Implementation Benefits
» Extremely flexible and resilient
» Very easy to set up transformations
» Scales well to reach multiple targets
» Homogeneous & Heterogeneous Sources

© IBMESBrporation 2004, K" _:"'1-»..-:;-_-_-_.: ™ "*"' BM Information Integration -
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SQL Replication Component Overview

SOURCE

NTROL

OUR CAPTURE CONTROL

a3

. DProp \
Capture

APPLY CONTROL

ROL

ADMINISTRATION

e T TR

Replication
Center

© IBIKsrporation 2004

Y4
10001
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TARGET
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Sample SQL Replication Scenarios

E"ﬂ"
—

E CcD cb E CcD

Update Anywhere

Transformation

= Subsets = Updateable Predicates
= SQL Transformations = Updateable Primary Keys

© IBIKsrporation 2004
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DB2 Data Replication from Federated SOURCES

SOURCE APPLY CONTROL
OUR CAPTURE CONTROL
ROL

[ATY . £ &
. rop Appl

ADMINISTRATION

N |

4
\

mwe
r0000 (currently
heterogeneous

. .- . .- replication with
Replication Replication sch Replication TARGET -
Center Monitor only) T

»DB2 »Informix

Federated Sources & Targets >Oracle >Sybase
»>SQL/Server >Teradata (Target only)

© IBIKsrporation 2004
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Replicated Data
> SQL Replication
> Q Replication
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Why Create Another Replication Architecture?

= Performance

» Combine high Throughput
with low Latency

= New Function

» Event Publishing
from DB2 and Classic Sources

= Capability

» Significantly improve multi-
directional Replication Support

= Manageability

» Reduce the number of
Replication Objects to be defined
and managed

» Ease the Definition Process with
new Replication Center Wizards

© IBMEsGrporation 2004, B - g ™ i o IBN mation Integration - z/OS landscape
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Q Replication Architecture

WebSphere Information Integrator introduces new replication architecture
for delivering extremely low latency replication

A

T S
Ny — |l 8
] Stored

: Rgm Apply Im
@ Federation Procedures
Log based

WebSphere MQ Engine

= Each message represents a transaction = Data Integrity
= Hi » Persistent messaging with
Highly parallel apply process WebsphereMQ

» Non dependent transactions

re-parallelized at the target > Detects missing messages

= Differentiated = Data transformation

conflict detection and resolution » Triggers on the target table
_ » Stored Procedures called by Apply
= Integrated infrastructure at the row level
for replication and publishing » Publish Event to user application

= DB2 to DB2 today

© IBMEsBrporation 2004, " TN £ 1 Information Integration - z/OS landscape
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Q Replication — Q Subscription Process

SOURCE

‘@,
S A
E:> 7w |
20
| - TeT2
. . v
Replication
Monitor \
% TARGET
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Transactional Q Capture

Restart
Queue

CAPTURE
In-Memory-Transactions

TX1: INSERT S1
TX1: UPDATE S1
TX1: COMMIT

TX3: DELETE S1
TX3: ROLLBACK| TX2: INSERT S2

MQ Put when Commit
record is found

TX1: INSERT St
TX2: INSERT S2
TX3: DELETE S1
TX1: UPDATE St
TX1: COMMIT
TX3: ROLLBACK

2

Transaction is still “in-flight*
“Zapped* at Abort Nothing inserted yet.
Never makes it to send queue

© IBIKsrporation 2004
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Q Replication — Defining Subsets or Filters

= Subset data
» Subset of rows through Q Capture predicate on subscription/publication
» Subset of columns through subscription/publication definition
» Signal (IGNORETRANS) defined to allow user selected transactions to be ignored

» Subscription/publication send options
« Change Only: Publish only columns that have changed vs all columns in the row
- All Changed Rows: Publish a row if any column changes (subscribed or not)
« Suppress Delete: Do not publish row deletes
- Before/After values: Publish before values as well as after values

= Predicate examples

» Based on values in the row data itself
WHERE :LOCATION ='EAST' AND :SALES > 100000

» Based on values in data in other tables

WHERE :LOCATION ='EAST' AND :SALES > (SELECT SUM (expense)
FROM STORES WHERE stores.deptno = :DEPTNO)

© IBMEeBrporation 2004, * R  Information Integration - z/OS landscape
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Q Replication - Transformations

= Transformations achieved through:
» Triggers on the target table

» Stored Procedures called by Apply at the row level

» Publish Event to user application

COL1COL2 COL3COL4 |

© IBIKsrporation 2004

Apply calls Stored Procedure ,
mapping columns to input parms

InParmi
InParm2
InParm3
InParm4

Update Target table X
where trg1 = “a”;

Stored Procedure performs logic
and makes insert/update/delete

TRG1TRG2 TRG3TRG4 |

mation Integration - 2/OS landscape
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Stored Procedures Apply

Apply via Stored Proc, why?
» Data Transformation (example later)
» Data Aggregation

> Anything different to what Q Apply does
Procedure

CALL

Out of QApply’s scope.

= Applying to a Stored Procedure means:

» Instead of executing I/U/D statements
a db2 registered Stored Proc is called by Q Apply

» Row operation and column values are passed as parameters
one row is one Stored Proc call

» Q Apply has no information at all about any target table

© IBMSBrporation 2004 " ol Information Integration - z/OS landscape
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Sample Q-Replication Scenarios

7 ?!ﬂ\? ﬂ
%i/ | @\l‘

Data Distribution (1:some)

© IBIKsrporation 2004

Bi-directional

Key Scenarios:

>

>

Low-Latency
Replication

Geographically
dispersed Applications
with distributed
Databases

Bi-directional
Replication with Conflict
Checking, Handling,
and Notification

Software-based Hot-
Standby

Cross DB2-Family
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Conflict Detection and Resolution

= Enables multi-directional replication that may result in conflicts

= Important for
» “Active” standby systems
» Workload balancing

= Value based conflict resolution
» 2 participating nodes
» Minimal overhead

= Version based conflict resolution
» 2 or more participating nodes (practical limit around 6)
» Requires extra columns and triggers
» Most robust conflict detection and resolution

1 B E Wk g ) : v e
© IBINsBrporation 2004 g+ g " « W IBN mation Integration - z/OS landscape
p _ ,




IBM Software Group | WebSphere Information Integration Software

Value Based Conflict Detection

= Do the current row values at the apply target match the old row (before
values) carried over from the source update?

= Designated site wins.

Server A (Winner) Server B (Loser) |

row (a,b,c) changed to (a,b,x) | row (a,b,c) changed to (a,z,c)

~ does old row (a,b,c) match ~ does old row (a,b,c) match
existing row (a,b,x) ?? existing row (a,z,c) ??

» No = conflict » No = conflict

» Who wins? = Server A » Who wins? = Server A

» Ignore the change, » Apply the change,
Log the conflict Log the conflict

» Row is (a,b,x) » Row is (a,b,x)

© IBMIEBrporation 2004, " R x Information Integration - z/OS landscape
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Value Based Conflict Detection and Resolution

= Disadvantage: Does not detect all possible forms of conflict
» Does not detect insert/insert+delete conflicts
» Is not offered for more than 2 participating database nodes

= Advantage: Requires less overhead
» No extra columns or triggers
» No effect to source updating applications
» Problematic conflict cases may not be applicable to user applications
» Can supplement with reconciliation utility (Tdiff/Trepair)
» Might be appropriate for planned outage/failover/DR

© IBMEsGrporation 2004, B - g ™ « WA IBN mation Integration - z/OS landscape
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Version Based Conflict Detection

= All rows are augmented with a “Version” = timestamp Tx and smallint Nx,
indicating when and by which server the row was last updated

= Do the current values of Tx and Nx at the apply target match the old values of
Tx and Nx carried over from the source update?

= Most current timestamp Tx wins.

Server A (N1) Server B (N2) |
row (a,b,c,T1,N1) row (a,b,c,T1,N1)
changed to (a,b,x,T3,N1) changed to (a,z,c,T2,N2)

» does old version (T1,N1) match » does old version (T1,N1) match
existing version (T3,N1) ?? existing version (T2,N2) ??

» No = conflict » No = conflict

» T3 > T2, T3 version wins » T3 > T2, T3 version wins

» Row is (a,b,x,T3,N1) » Row is (a,b,x,T3,N1)

©)IBINsGrporation 2004, e - N g IBM Information Integration - z/OS landscape
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Version Based Conflict Detection and Resolution

= Advantage: Detects all possible forms of conflict
» Based on time zone adjusted timestamps
» Theoretically can support any number of participating database nodes
» Practical limit for V8.2 is about 6

= Disadvantage: Requires more overhead
» Requires versioning columns on tables (admin adds)
» Requires triggers to maintain versioning columns (admin builds)
» Does impact source updating applications
» All participating nodes must be connected to all other participating nodes
» Time zones can vary , but machine clocks should be well synchronized

» Clocks that are off will slow down the Apply — data from the future will never be
applied

© IBMEEBrporation 2004 Bk B .*" ?E Information Integration - z/OS landscape
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Feeding Trade-History Database with Q-Replication

f L 7
K :
4 X ACE
-\, Trade History
« f Applications
i
Applications Trade
Processing Tra
Data History

Business Scenario Data

» In many Online Environments OLTP Data is kept separately from
Query/History Data for better Performance of both Update and
Query Applications

> This user has just made an Online Trade — he will keep hitting
Enter until he sees that the Trade is complete, in this Case
meaning it has been replicated to the Trade History Database

© IBVIKstirporation 2004
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High-Availability Solution built upon Q-Replication

Read Only Applications

‘\ Read/Write Applications
7

SOURCE

Primary Database

Business Scenario

Q- Apply 1
SOURCE _ ikt
B SouRce_

W-Capture

> Replication Processes and Subscriptions are defined in both Directions, but Data

mainly flows in one Direction at a Time

Y VY

only” Applications permanently

Recursion is stopped by Capture, which reads special logged Events created by Apply
Data at the Secondary System is transactionally consistent and is available for “read

» Procedures for Failover and Switchback will depend on which Options have been

selected for Conflict Detection

© IBVIKstirporation 2004
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Summary — Q-Replication Overview

= Q-Capture
» Captures Changes from DB2 Log into Message Queue(s)
» Websphere MQ replaces the use of Staging Tables (CD Tables)
» Each Message represents a Transaction
» Very Compact Internal Message Format

= Q-Apply
» Highly-Parallel Apply Processing
» Conflict Detection, Resolution and Documentation

= Websphere MQ
» Robust, Secure, and High-Performance Messaging Infrastructure
» Available on all commercially relevant Platforms

© IBVINsGrporation 2004, S - G - « Fas IBN mation Integration - z/OS landscape
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IBM’s Information Replication Architectures

= SQL-Replication (Formaly and still known as DataPropagator)
» Log-based asynchronous Change Capture

» Versatile Replication Architecture for Data Replication between all Members of the
DB2 Family and beyond (in Combination with WebSphere Information Integrator)

» Relational Staging Concept
» Successfully used for Years by huge User Community

= Q-Replication / Event Publishing
» Log-based asynchronous Change Capture
» Captured Transactions immediately sent via Message Queues
» High-Volume, Low-Latency Architecture

= HADR (DB2 UDB for Linux, Unix, Windows only)

» Replicates entire Database by Log Buffer Shipping (over IP)
» Initially no Read-Access at Secondary Site

© IBMIEBrporation 2004, ol Information Integration - z/OS landscape
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Event Publishing
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Why Publish Data?

= Database to Application Messaging
» Drive downstream Applications or APIs based on the
Transactional Data of the changed Database Events
= Event Notification
» Stream changed Data Information to Web Interfaces
» Stream only particular Events of Interest (filter Data)

= Data Warehouse / Business Intelligence
» Integrate captured Changed Data with an ETL Tool
» Perform complex Transformations with custom Logic
» Use a specific Transaction Format to update Target

= MQ provides guaranteed delivery
» Avoids the need for 2-Phase-Commit (2PC)
» Works even when the Target is not available

© IBMSBrporation 2004 = Information Integration - z/OS landscape
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Publishing data events to facilitate business integration

Capture database changes as XML messages
and publish them to WebSphere MQ

= Function

» Publish events to a message queue
» XML self-describing format (UTF-8)
» Wizard-driven configuration

= Usage
» Application to application
messaging
» Event streaming
» Source for ETL tool

/ DB2 UDB
Log-based
capture

&

IMS  wsi
IDMS Capture
VSAM WebSphere MQ

© IBVIKstirporation 2004

WebSphere
Business Integration

WebSphere MQ User

Integrator Broker Application

JMSaware
Application
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DB2 Implementation: Process Flow

SOURCE

sl
stz sy § 5 0§ | ovwe | ver

Replication

Center Monitor TARGET
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Event Publishing - Publication Options

= Format
» Only data from committed transactions is published
» Data is self describing with XML tags
» Row based = one row per message
» Transaction based = one transaction per message

= Row Content
» Subset by column
» Subset by predicate
» Changed column values only or all column values
» New data values only or include old values

© IBVIKstirporation 2004
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WebSphere Information Integrator Event Publishers for z/OS

= Real time DB2, IMS, VSAM and CA-IDMS
changed-data capture and publishing

= Publish to WebSphere MQ

= Relational XML format

= WebSphere listener application/tool
» Picks up message(s)
» Takes action

= Two Event Publisher infrastructures:

» DB2 Universal Database for z/OS
- Based on
WebSphere Il Q-replication
» IMS, VSAM and CA-IDMS*

- Based on DB2UDB  CICS-made VSAM IMS
WebSphere Il Classic Federation for z/OS changes changes changes

Capture, Externalize (XML) and Deliver to MQ
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DB2 UDB for z/OS Implementation

= Leverages Q Replication infrastructure
» Replication Center metadata management
» Capture and Publish with no Apply

= Log-based changed-data capture

» Log Buffer - Active Log - Archive Log
with seamless transition

= Transaction aware
» Each message represents a DB2 transaction

= Publish XML format messages

» XML format is consistent with other z/OS
event publishers (IMS and VSAM)

= Upgradeabile to full Q Replication

© IBMIEBrporation 2004, B = - E i Information Integration - z/OS landscape
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Classic Event Publisher: IMS & VSAM Implementation

= Change capture agents intercept changes
» Active log stream capture or log file access
» Changes are forwarded to the correlation service

= Correlation service
» Sorts data by unit-of-work identifiers
» At end of unit-of-work
 Rollback - flush all data for this unit-of-work
- Commit - reformat data into relational XML messages
- push data to the publication service

» Metadata catalog holds mapping between IMS and
VSAM changes and relational table/column definitions
that will be published

= Publication service

» Manages publication to WebSphere MQ persistent
queue

» Initiates recovery data update with the correlation
service

» Queue info is defined in configuration files

eta
cat
<>
 ——

change capture
agents

CHANGES

. |~ i i 1 " ‘ " )
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Combining SQL and Q Replication with Event Publishing

_ Staging Tables

Log Reader 1 E — ;
Capture Schema |
S s | Nomen

Q Sub ﬂ
Q Capture T »

Log Reader 2 Schema @
“CAP2”

E Event Pub ﬂ
User |
Application |

SQL Replication and Q Replication can co-exist
» Managed at source by using multiple capture schemas
» One Q Capture can handle both Publications and Subscriptions
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WebSphere Il Event Publisher & Business Intelligence
Feeding Changed Data to :

» Data Warehouse
» Datamart
» Operational Data Store (ODS)

Optimize Resource Utilization

» Minimize Bandwidth Requirements

» Maximize Data Currency 1010310110010 001 0010100011010 00101004 010100101010107
WebSphere:-information:integrator
Event Publishers-for:z/OS

Complements with
WebSphere Il Federation

> Data feed using Event Publishers DB2 UDB
for z/OS
» Real-time extensions using Federation
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WebSphere Il Event Publisher & Business Integration

Data “Events” drive business integration

» Seamless integration with EAl via WebSphere MQ

Data used to drive EAl workflow

> Inventory update hits threshold...
triggering restocking process

» Addition of new customer:
v Initiates welcome email
v" Credit verification

v" Accounting updates
Vo

Cross-silo data synchronization

» Synchronize mainframe updates with:

v CRM
v ERP
v" HR, etc.

e

Senvice

m SEeBEYOND
WebSphere

IEBEL.
v

WebSphere Information;Integrator
/ Event Publishers for z/OS \

30 @

DB2 UDB for z/0S VSAM IMS

mation Integration - 2/OS landscape
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Sample Application

= Near real-time cross-silo data synchronization
» Loosely coupled integration
» Minimizes development effort
» Simplifies maintenance

e.g- New order data is automatically pushed to a CRM application
e.g. VSAM employee data updates are pushed to SAP payroll

Customer <" - ¢ [—
Updates - = 4 WebSphere
| ic E “ BUsiness

Integrator

, B ® ok i . ‘ " e
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Order Processing — Exploiting || Event Publishing

Billing Request
Creation

W-Capture

(érder PETETEFS
ntry rder
Applications Processing
Data
Shipping Request
Creation

Business Scenario
> As new Orders are entered into the Order Entry System, the pertinent Data is
captured and published into a Queue

> The Websphere MQ Integrator Broker processes the queued Data

> A billing Transaction is created and queued in one System and a Shipping
Transaction is created and queued in another System
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Sample Application

= Event Notification
» Receivable balances approaching credit limit pushed to a credit analyst
« Threshold is independent of order processing and accounting applications
* No “hard-hooks” in OLTP applications necessary

I:,Orders,
ayments, WebSphere
Returns, B —
etc. Y Iﬁresglp:tisr NGt CredibAnZISE Z
T I
| Credit
Analyst’s
Portal

, .} E L ) : v e
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Why data events versus application events?

Integration is independent of the source applications

» Applications grow and evolve with
“minimal impact on the integration “

» Relatively straight forward to find data items
“ rather than every business rule “

» e.g.many applications change inventory
but the data values trigger re-stocking

» e.g. many transactions impact Claim status
changes to status value drives workflow

» e.g. order data is needed by a CRM
CRM has no dependence on ordering process
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Using Classic Il Event Publishing for Replication

!

IMS data i |s
updated Stored procedure
generates DB2
@ I/U/D statements
Data is Captured \

= |t is our direction to support replication of Classic data sources using the
highly parallel Q Apply of WebSphere Il Replication.

near real time

= As an interim suggestion, SQL stored procedures can be used to apply the
data captured through the Il Classic Event Publisher
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Summary

= Information integration is a foundation for companies to build an On Demand
Operating Environment enabling them to align their IT infrastructure to
business priorities

= WebSphere Information Integrator provides access to diverse, distributed, and
real-time data as if it were a single source, no matter where it resides.

= WebSphere Information Integrator will help businesses
» Optimize IT investments given more choice in data access
» Improve productivity and application efficiency
» Enable greater return on existing assets

= Rely on IBM’s proven technology and support for open standards
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WebSphere Information Integrator Packaging and PIDs

Distributed (Linux, UNIX, Windows)

WS Il Advanced Ed. Unlimited PID 5724-C74

WS Il Advanced Ed.

WS Il Standard Ed.

WS I
Replication
Ed.

WS Il Event
Publisher Ed.

WS Il Developer Edition
PID 5724-C74

WS Il OmniFind Edition (same as for
WebSphere

I
 Processor-based pricing except for Developer I'—Iaition
which is priced by user
* Priced Connectors to access non-IBM sources

Mainframe (IBM eServer zSeries)

WS Il Classic Federation for z/OS
V8.2

DB2 Il DataPropagator for z/OS
V8.2 (SQL Replication)
WS Il Event Publisher
for DB2 UDB for z/OS V8.2

WS Il Replication for z/OS V8.2
(SQL+Q Replication, Event Publishing)

WS Il Classic Event Publisher
for IMS v8.2

WS Il Classic Event Publisher
for VSAM V8.2

WS Il Classic Event Publisher

for IDMS V8.2

« Value Unit pricing Model
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Replication and Event Publishing Products : z/OS

SQL Replication Architecture (DProp Capture and Apply)
» Available for DB2 UDB z/OS V7 and V8

Q Replication and SQL Replication Architecture

» Includes Event Publisher

» Available for DB2 UDB z/OS V7 and V8

» Websphere MQ prerequisite when using Q Replication

Event Publisher for DB2 (Q Capture)
» Websphere MQ prerequisite

Event Publisher for IMS
» Websphere MQ prerequisite

= Event Publisher for CICS/VSAM
» Websphere MQ prerequisite
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= SQL Replication Architecture

DB2 UDB V8.2 = SQL Capture and SQL Apply o
for Lintix, Unix, Windows (for all DB2 UDB V8 Editions incl. Partitioning Feature)
includes DB2 DataPropagator . = DB2 Sources and Targets. Informix IDS Sources and
Targets supported through Federation Capability

VWERSPIETE: oo % " SQL Architecture: DB2 & multi-vendor Sources and Targets
oAl ITEdYAIoL, = Q Architecture: DB2 Sources and Targets

Replication Edition

/8:2 = Note that Websphere MQ is bundled with this Product

— memee = Q Architecture: DB2 LUW Sources
o WEDSPHEIE. LS. . Note that Websphere MQ is bundled with this Product
nformation Integrator.

Event PublisherEdition = Data Changes pubished through Message Queues in
/8.2 external XML Format
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